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Monitoring Program User’'s Guide
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1 Start and Settings

4 Introduction to the DMS program

m Features

e The Doosan Excavator/Wheel Loader Monitoring Program (also called “DMS-3") offers
the following functions by connecting Controller (EPOS or VCU) with the user’s IBM PC
compatible PC.

1. Monitoring: You can monitor the current status of equipment installed with
Controller (EPOS or VCU).

2.  Graph Output: The major excavator/Wheel Loader sensor data will be displayed in
a graph format. The data can be saved in the hard disk. You can check the
excavator/Wheel Loader’s performance through data comparison and analysis.

3. Force Operation: You can use vehicle diagnosis by forcing Controller (EPOS or
VCU) outputs.

4. Diagnosis: You can check the real-time and past malfunction history maintained by
Controller (EPOS or VCU).

5. History Data: You can analyze the work patterns when using an excavator/Wheel
Loader, by checking the operation hours, filter/oil information, and daily operation
information.

m Hardware connection

e A separate communication cable is required to establish communication between
Controller (EPOS or VCU). and external PC. The communication cable should be
connected to the excavator/Wheel Loader’s maintenance connector and user PC’s Serial
port.

Note) Please turn the excavator/Wheel Loader power off, when
connecting/disconnecting the cable.




m Program Menu

e DMS is mainly composed of the following menus.

DX300LC-3
File Wiew Connect Settings Tools  Window Help
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1. File: Open, Close, Save, Save As, Change Model, Page setup, Print, Recent File,
and Exit.

2. View: Monitoring, Graph Output, Force Operation, Diagnosis, History Management,
Parameter, Work Window, Toolbar, Status bar.

3. Connect: Connect, Disconnect, Start Monitoring, Stop Monitoring, Vehicle
Information.



4. Settings: Units and Language.

5. Tools: Download Program and Download Wheel Loader Parameter Map, Expert
mode, VBO Diagnostic tools, Password Initialization.

6. Window: Cascade, Tile, Arrange Icon, and Close All

7. Help: Help, About..

4 The DMS-3 program support the following excavator and wheel loader models.

® [Excavator

No | Model name ‘
DX140LC-3
DX140LCR-3
DX140W-3
DX170W-3
DX180LC-3
DX190W-3
DX210W-3
DX210LCR-3
DX225LC-3
DX255LC-3
DX300LC-3
DX340LC-3
DX350LC-3
DX380LC-3
DX420LC-3
DX490LC-3
DX700LC-3
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® \Wheel loader
No Model name
DL200-3

DL250-3
DL300-3
DL350-3
DL400-3
DL450-3
DL550-3
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2 Installation

4 Program installation (PC installation)

B Recommended System
- OS: IBM compatible PC (Windows XP Over)
— Processor: Pentium Il 800MHZ Over
- Memory: 256MB Over

M Installing the program

e You can install the DMS monitoring program automatically by executing “DMSSetup.msi”.
If the monitoring screen or graph display screen is not displayed normally after installation,
please refer to the following manual installation method.

1. Double click the “DMSSetup.msi” file.

Welcome to the DMS5-3 Setup Wizard

The inztaller will guide pou through the steps required to ingtall D5-3 on wour computer,

WARMIMG: This computer program is pratected by copyright lavw and international treaties.
Unauthorized duplication or distribution of this program, or any portion of it, may result in severe civil
or criminal penalties, and will be prosecuted ta the masimnum extent poszible under the law.

Cahicel




3. Select the DMS installation folder and click [Next].

Select Installation Folder

The inztaller will ingtall DbS-3 to the following folder.

To install in this folder, click "Next". To install to a different folder, enter it below or click "Browse".

Folder:

CProgram FileswlhoosantDhi5-3w Browse. .

[ Cancel ] [ < Back ] [ Mewut » ]

4. Click [Next], if you're ready to install DMS.

Confirm Installation

The installer is ready to install DS-3 an your computer.

Click "Mest" to ztart the installation.

’_ Cancel ] ’_ < Back ] [ Mewt> |




Installing DM5-3

DMS-3 iz being inztalled.

Fleaze wait...

< Back Mext »

Note) If you want to stop installation in the middle, you have to click [Close] and start
installation again.

Installation Interrupted

The installation was interrupted before DMS-3 could be installed. *v'ou need ta restart the installer
Lo by again.

Cancel < Back




5. Click [Close] when DMS is installed successfully.

Installation Complete

DM5-3 haz been successfully ingtalled,

Click "Close" to exit,

Cancel < Back

6. Open the DMS installation folder and click the “DMS-3.exe" file.
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3 Menu

3.1 File
4 This section describes the “File” menu of the DMS program.

DX300LC-3

&N Wiew Connect Setfings Tools Window Help
Open Chrl+0 » Em

Close

Save Chrl+5
Save As

Change Model

5[

Page setup
Print Ctrl+P

Fecent Files

Exit |

Operation
Filter-Qil In

Daily Cper

M Open...<Ctrl+O(0)>

Use this menu to open the saved file.

Select [File] — [Open].

When the [Open] dialog box appears, select a drive or folder that contains the target file
in “Find in".

4. Select a file from the “Open File” dialog box.

5. Click the [Open] button to open the selected file.

'}

6. &

whN e

is the shortcut icon and the file extension is (*.ddms).
H Close (C)

1. Use this menu to close the monitoring window on the DMS program screen.
2. Select [File] — [Close].
3. All windows on the DMS screen will be closed at a time.

B Save <Ctrl+S(S)>

1. Use this menu to save the monitoring window on the DMS program window.

2. Select [File] — [Save].

3. Select a folder to save a file.

4. Input the name of the file to save in the [File name] field and click the [Save] button.
5

= is the shortcut icon and the file extension is (*.ddms).
M Save As (A)...

1. Use this menu to save the monitoring window on the DMS program window, using the
different file name

2. When the [Save As] dialog box appears, specify a drive or folder to save a file in [Save
in].

3. Input the name of the file to save in the [File name] field and click the [Save] button.



l Change Model

1. Use this function to change the model that is being monitored on the DMS program
window.

Select [File] — [Change Model].

Select the model from the “Select Model” dialog box.

You can see that the changed model name is displayed on the DMS program caption
bar.

rpON

Dx300LC-3
File View Connect E_) File Miew Connect Se

ex,) DX300LC -3 — DX140W-3

Note)
1. You need to close and open the monitoring window again to see the changed

model name.
2. If connected to the vehicle, the vehicle model name will be set automatically.

m Print Settings
1. When you set the printer and paper size to print and use.
2. Select [File - Print Setup]
3. Used to set the printer and paper size.

m Print
1. DMS has been monitoring the window screen number is used to print
2. Select [File — Print]
3. DMS has been monitoring the window screen is output.

m the most recently used files
1. Displays recently used files

= Exit (X)

1. Use this menu to close the DMS program.

2. Select [File] — [Exit].

3. All opened windows on the DMS program screen will be closed, and the DMS program
will be terminated.



3.2 View

4 This section describes the [View] menu of the DMS program.
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m Monitoring

1. Select [View] - [Monitoring].
2. The [Basic] window will appear on the DMS screen.

m Logging Data

1. Select [View] - [Monitoring].
2. The [Graph Output] window will appear on the DMS screen.

m Force Operation

1. Select[View] - [Force Operation].
2. The [Force Operation] window will appear on the DMS screen.

m Diagnosis

1. Select [View] - [Diagnosis].
2. The [Diagnosis] window will appear on the DMS screen.

m History

1. Select [View] - [History].
2. The [Fuel Consumption Info.] window will appear on the DMS screen.
3. When the history window appears on the DMS screen, select [View] — [Refresh] or use

+
the shortcut icon L7 to update the history data.




m Parameter

1. Select [View] - [Parameter].
2. The [Parameter Modification] window will appear on the DMS screen.

m Status Bar

1. The red LED will flash when monitoring begins.
&0 LM

2. The red LED will be turned off when monitoring stops.
a8 ML



3.3 Connect
& The correct data should be entered for communication, in order to

synchronize with DMS-3 program, which enables the user to check the
characteristics of the vehicle, with the vehicle controller (EPOS/VCU).

| Setfings  Tools Window Help

Disconnect F8

Start Manitaring F3
Stop Monitoring ESC

5 “ehicle Information

® Kj Histary Data

@ Pararnetar

X1 NUM




Bl Connect

1. Select[Connect - Connect].

Note) Please check the port number of the PC in question, when setting the connection port
(B).

€ Check port

® Check Port to be used on port entry of PC's Device Manager.
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COM port selection rzl

COM Port: | COM3 o |

Baud Rate:

Data Bits:

Parity:

Stop Bits:

2. Set the COM port as shown above and click [OK] to establish communication with
equipment.

Shortcut @

icon

H Disconnect

1. Select[Connect - Disconnect].

Shortcut @

icon




M Start monitoring

1. Select[Connect — Start monitoring].

Shortcut = @

icon

H Stop monitoring

1. Select[Connect — Stop monitoring].

Shortcut 4 @

icon




3.4 Settings

4 This section describes “Setting” menu of the DMS program.

File Miew Connec Tools indow  Help

== 5‘?”‘4 Units
———1

Language

!_ Monitoring
D Graph Qutput
m Force Operation

\j Diagnosis

Vs | History Data

@ Pararneter

@ @ LR

H Units (V)

e A different unit can be used for the temperature and pressure excavator/wheel loader
sensor data, depending on the location. You can set the unit you want on this screen.

1. Select [Setting] - [Units].
2. Set the proper unit for pressure and temperature.

Unit Set X
e
(®) bar: O Kaffem2
........ ; -—Car1 ol
O psi COxpa
Temperature
®-=C OF

3. Click [OK] to apply settings.
4. Sensor values will be displayed after conversion, using the unit selected here.



M Language (L)

e This program supports English and Korean. You can select your preferred language on this
screen.

1. Select[Setting] - [Language].

2. Select Korean or English.

3. Click the [OK] button to apply setting.

NOTE) The selected language will be applied when the program is re-started.

bMs-3 X

() Korean

f": Apply after restarting Program |
L]




3.5 Tools

4 This section describes the [Tools] menu of the DMS program.

W | History Data
= L3

& promen

m Download Program (D)

e Use this function to modify the controller (EPOS/VCU) program when performance is
improved. You can add the controller function simply by modifying the program, instead of
modifying controller hardware.

» How to change the controller (EPOS / VCU) program
1. Vehicles from the computer while the power is turned OFF (laptop) to connect to a PC

CHECK CABLE to connect to the vehicle CHECK CONNECTOR.

il

2.

Fart:

COMI Frogram




3. Select the communication port on the “Firmware Update” window, as shown above, and
click the [Program] button. Then, you can select the data file (*.hex) from the folder
where the VCU program is installed.

&= oF): | 9 down v QT i@

Y [ svn
) Icyclasses
wEZ A (Slb
= 5 Output

tar

[ EEPD:

CCEC I T
__J |#]test
lH 2
TEES]
WUEA2 83 o gigqy:  [EPoS2e - @0 |

T "D [shex [

4. Select the file and turn the toggle switch of the PC check cable on to start the download
mode in the controller. Then, turn the vehicle power on to display the following program
update progress.

Programming...

[-------------------------- ]

Ba%

5. When EPOS/VCU program update is completed, click [OK] and make sure to restart the
excavator/wheel loader. At this time, PC CHECK CABLE create a toggle switch to the
OFF state to the controller to switch to the normal operation mode

1 ) Firrnware update was successful,




m Expert mode

e You need to have the expert mode right to use the DMS function that can change the
equipment setting information. Use this menu to check the expert mode right.
The following jobs require the expert mode right.

% Force Operation, Delete Failure History, Delete Fuel Usage Information, Delete Operating
Time Information, Delete Filter/Oil Information, Download Program, Edit Parameter

1. Select [Tools]-[Expert mode] menu. Input the password for the professional mode on
the “Enter Password” window.

Enter Password

Enter Password. l QK ][ Cancel ]

m VBO Diagnostic Tools (F4)

e Use this menu to diagnose and tune equipment that uses the VBO electronic pump function.
(DX340LC-3 / DX350LC-3 / DX380LC-3) The menu will be enabled only when connected to

the electronic pump.
For more details on the use, refer to the “YBOManual.pdf” file.

VYBEO Diagnosis

pOOSAN

2. Swash Plate . EPPR V|V 4. Main Pump 5. Relief
Angle Check Check Pressure Check Pressure Check

m Password reset

e Use this menu to initialize the password of equipment that is locked with the startup limitation
password. Both user and administrator passwords will be initialized.



3.6 Window

4 This section describes the “Window menu of the DMS program.

DXx340LC-3
File Miew Connect Settings Tools 1do
Jﬁu §?| |J2X H LCascade
Tile Horz
Arrange
=2 - Monitoring
- Close All
Basic
Digital In-0Out
Analog In-Out

WBO/Electronic Pump

Engine Characteristics

@ Graph Output
m Force Operation

# Diagnosis
= @‘b:“ History Data

1 Fuel Consumption Info

2 Operation Time

3 Filter/0il Info

Daily Operation Infa

e 4
@ Paramneter

& @ MUK,

M Cascade (C)

1. Select [Window] — [Cascade] menu.
2. Displays the monitoring windows in the cascade mode.
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W Tile (T)

1. Select [Window] — [Tile] menu.
2. Displays the monitoring windows in the tile mode.
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M Arrange (A)

1. Select [Window] — [Arrange] menu.
2. You can arrange window icons.
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H Close All

1. You can close all monitoring windows of the DMS program at a time, using this menu.
2. Select [Window] — [Close All] menu.
3. All monitoring windows will be closed. (See the first image.)



3.7 Help

4 This section describes the [Help] menu of the DMS program.
M Help

< DX140W-3
Eile  Wiew Connect Settings Tools  Window SEE

=] ! Monitaring
1 Basic
2 Digital In-0ut

-3 Analog In-Cur

Y| WBO/Electron

Engine Chara

5
{E Graph Output

rﬁ Force Operation
----- ‘f_’;?" Dizgnosis

= g? History Data

E 1 Fuel Consum
2 Operation Tir

: 3 Filter/Cil Infa

- Daily Operatic

M Help
1. Select [Help]-[Help].
2. You can display the DMS help file.



Ml About ..

DX140W-3
Eile  Miew Connect Settings Tools Window Naill

----- Manitaring

Basic
2 Dighal In-Out

--------- 3 Analog In-0Ou

4 WBO/Electron

---------- Engine Chara

5
........ {E Graph Output
rﬁ Farce Operation

......... \":*2 Diagnosis
=] '&7 History Data

[ Fuel Consum
[ Operation Tir

3 Fiker/Oil Info

.......... Daily Operatic

4
@ Parameter

1. Select [Help]-[About].
2. You can display the DMS version information.

DMS Info

DMS version 1.0 2011.08 oK

% Copyright (C) DOOSAN INFRACORE 2010
All rights reserved.

3. ® isthe shortcut icon.
4. Click the [OK] button to close the “DMS Info” window.



3.8 Workspace

@ This section descries the “workspace window” of the DMS program.

DXxAZ20LC-3
File Mew Connect Settings Tools MWindow Help
2d = 2 BRI
x
B------_‘ Manitaring
Basic
Digital In-Out
Analog In-0ut

e By
{E Graph Qutput
m Force Operation

5? Diagnosis

=k | History Data

YEO/Electraonic Purnp

Engine Characteristics

-1 Fuel Consurnption Info
2 Operation Time
-3 Filter/0il Info

-4 Daily Operation Info

@ @ UM

B You can execute six items in the “View” menu quickly and conveniently,
using the icons located at the left side of the program window.

1.

wn

Monitoring

Excavator - Basic, Digital In-Out, Analog In-Out, VBO/Electronic Pump, Engine
Characteristics.

Wheel Loader - Basic, Digital In-Out, Analog In-Out, Elec MCV, Transmission, Engine
Characteristics.

Graph Output: The monitoring data will be displayed as a graph.

Force Operation; You can test equipment by entering the value you specify into the
particular equipment data.

Diagnosis: You can diagnose equipment malfunction. The current malfunction
information and history will be displayed.

History Data: Fuel Consumption Info., Operation Time, Filter Oil Info, Daily Operation
Info.

Parameter: You can read/write some parameters for equipment. The menu runs in the
professional mode.



4 Easy guide

4 Take the following steps to run Doosan Excavator/Wheel Loader Monitoring

Prog

1.

ram (DMS).

Select [Start] - [All Programs] — [DMS-3] menu, or click the “DMS-3" icon on the
desktop screen.

%nms—a

2.

When the DMS screen is opened, select [File] — [Change Model] to select the model you
want.
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Select the model you want and select [Connect] — [Connect] menu, or click the
“Connect” icon to establish communication with Controller (EPOS OR VCU).
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polsWindow Help
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4. When connected to Controller (EPOS OR VCU) successfully, you can check the data in

real-time on multiple windows.
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Note) When monitoring is started, other monitoring windows on the DMS screen will

not be closed and any new window will be opened.



5 Monitoring
5.1 Default

4 Use this function to check various data related to an excavator/wheel loader.

1. Select [View] — [Monitoring] menu on the DMS main screen, or double click
[Monitoring] — [Basic] on the workspace window.

DX490LC-3 - [Basic]
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Note) The data displayed on the screen can be different, depending on the model.

2. You can see the following data on this screen.

¢ Crawler Excavator(14~30 ton)
1) Sensor data: various kinds of analog sensor data will be displayed.

. Engine Speed (rpm) . Pump Control P/V (mA)
. Dial (mV) . Flow Control P/V (mA)
*  Acceleration Pedal Position (%) . Hyd. Oil Temp(°C)

. Front Pump Pressure (Bar) «  Coolant Water. (°C)

. Rear Pump Pressure (Bar) . Battery (V)

. Boom Pressure (Bar) e Fuel (%)

2) Power Mode State
*  P+: Power Plus Mode e E:Economy Mode
« P :Power Mode ¢ AUTO IDLE : ON/OFF
e S: Standard Mode



¢ Crawler Excavator(30 ton)

1)

Sensor data: various kinds of analog sensor data will be displayed.

Engine Speed (rpm)

Dial (mV)

Acceleration Pedal Position (%)
Front Pump Pressure (Bar)
Rear Pump Pressure (Bar)
Boom Pressure (Bar)

Pump Control P/V (mA)

Power Mode State
P+: Power Plus Mode
P : Power Mode
S : Standard Mode

¢ Crawler Excavator(30 ton~)

Cooling Fan P/V(mA)
Flow Control P/V (mA)
Hyd. Oil Temp(°C)
Coolant Water. (°C)
Battery (V)

Fuel (%)

E : Economy Mode
AUTO IDLE : ON/OFF

1) Sensor data: various kinds of analog sensor data will be displayed.

L]

L]

L]

Engine Speed (rpm)

Dial (mV)

Acceleration Pedal Position (%)
Front Pump Pressure (Bar)
Rear Pump Pressure (Bar)
Boom Pressure (Bar)

Pump Control P/V (mA)

2) Power Mode State

¢ Crawler Excavator(VBO, 34/38 ton)

P+: Power Plus Mode
P : Power Mode
S : Standard Mode

Cooling Fan P/V(mA)
Flow Control P/V (mA)
Hyd. Oil Temp(°C)
Coolant Water. (°C)
Battery (V)

Fuel (%)

E : Economy Mode
AUTO IDLE : ON/OFF

1) Sensor data: various kinds of analog sensor data will be displayed.

Engine Speed (rpm)
Dial (mV)

Acceleration Pedal Position (%)

Front Pump Pressure (Bar)
Rear Pump Pressure (Bar)

Boom Pressure (Bar)



Pump Control P/V1 (mA)

Coolant Water. (°C)

. Pump Control P/V2 (mA) . Battery (V)

¢ Cooling Fan P/V(mA) . Fuel (%)

e Hyd. Oil Temp(°C)

2) Power Mode State

. P+: Power Plus Mode e E:Economy Mode

. P : Power Mode e AUTO IDLE : ON/OFF

. S : Standard Mode

¢ Wheel Excavator

1) Sensor data: various kinds of analog sensor data will be displayed.

. Engine Speed (rpm) . Pump Control P/V (mA),
. Dial (mV) . Flow Control P/V (mA)

»  Acceleration Pedal Position (%) . Hyd. Oil Temp.(°C)

¢ Accel Pedal (mV) . Coolant Water (°C)

. Front Pump Pressure (Bar) . Battery (V)

. Rear Pump Pressure (Bar) . Fuel (%)

. Boom Pressure (Bar) . Speed Meter (km/h)

. Pilot Gear-Pump Pressure (Bar)

2) Power Mode State

. P+: Power Plus Mode . E : Economy Mode

. P : Power Mode . AUTO IDLE : ON/OFF
* S: Standard Mode

¢ Wheel Loader — Doosan Engine
1) Sensor data: various kinds of analog sensor (Engine Speed, Pump Pressure)

data will be displayed.

e Vehicle Speed (km/h) e Torque Converter Qil(°C)
. Engine Speed (rpm) e Sump Oil Temp (°C)

e Accel Pedal Position (%) . Fuel Level (%)

. Fan Control P/V(mA) . Battery (V)

e Coolant Temp.(°C)



2) State : You can check the status of Wheel Loader output

. Current Direction
. Current Actual Gear
. Select Gear

. Engine Power Mode

Transmission Mode
Auto Idle

Warm Up

Angle Set Mode

3) Warning : You can check the Warning status of Wheel Loader output

. Engine

*  Water In Fuel

e Charge

. Engine Oil Pressure
e Transmission

. Engine Stop

¢ Wheel Loader — Scania Engine

L]

Preheat

DPF

HEST

Prohibit Regen
Quick Clamp

1) Sensor data: various kinds of analog sensor (Engine Speed, Pump Pressure)

data will be displayed.
. Vehicle Speed (km/h)
. Engine Speed (rpm)
¢ Accel Pedal Position(%)
. Fan Control P/V(mA)
e Coolant Temp.(°C)

Torque Converter Qil(°C)
Sump Oil Temp (°C)
Fuel Level (%)
DEF(AdBIlue)Level (%)
Battery (V)

2) State : You can check the status of Wheel Loader output

. Current Direction
. Current Actual Gear
. Select Gear

. Engine Power Mode

Transmission Mode
Auto Ildle

Warm Up

Angle Set Mode



3) Warning: You can check the Warning status of Wheel Loader output

. Engine, e Transmission

e Water In Fuel . DEF(AdBLue) Low
e Charge e SCR Fault

. Engine Oil Pressure *  Quick Clamp

Note) The data displayed on the screen can be different, depending on the model.
Please refer to the equipment specification.



5.2 Digital In/Out

4 Use this function to check various data related to an excavator/wheel loader in
real time.

1. Double click [Monitoring] — [Digital In-Out] on the workspace window of the DMS main

screen.
" DX300LC-3 - [Digital In-0ut] EEE]
E File Miew Connect Tools Window Help -8 x
] ? % u
= . =]
Digital Input
= _ Manitoring . Alternator ' Air Cleaner Indicator ' Pilat Filker ' Return Filter
1__Sasic Bl ister in Fuel s stetus
2
Bwitch
3 #nalog In-0u
' Power Max ' Breaker Operating ' High Speed Select{Manualy ' High Speed Select{Auta)
4 WBO/Electron
. Working Lamp Quick Clamp Aircon Switch One Touch Decel. Switch
5 Engine Chara ' ' . .
‘LE Graph Output . Inteligent Boom Swich | Pilat Cut OFF . OWD Select Switch . Pedal Breaker Press. Switch
p H Force Operation Pt | Patttern Change(150) | Pattern Change(BHL) Bl Swina slsrm Select Switch
el . .
\.f' Diagnosts - Trawel Alarm Seleck Switch ' Swing Press. Switch ' Starker Switch
{& | History Data
) Solenoid Valve
@ Parameter Bl negacon cut spv Ml Relief Pressure Up 51v Ml 2 Fump Select 5y Ml High Speed Siv

' Breaker Operating Siy

Relay

. Starter Relay ' Backup Alarm Relay

< I 5
X1 KM

Note) The data displayed on the screen can be different, depending on the model.

2. You can check the following data on this window.

¢ Crawler Excavator(14~30 ton)
1) Digital Input: You can check the status of the vehicle

" Alternator = Return Filter
. Air Cleaner Indicator =  Water in Fuel

. Pilot Filter = TMS Status



2) Switch: You can check the status of the user's operation

=  Power Max =  Working Lamp,

=  Breaker Operating =  Quick Clamp

= High Speed Select(Manual) *  Preheat

= High Speed Select(Auto) = Aircon Switch

= One Touch Decel. Switch =  Pattern Change(BHL)

= Intelligent Boom Switch =  Swing Press Switch

*  Pilot Cut Off = Starter Switch

=  OWD Select Switch =  Swing Alarm Select Switch
*=  Pedal Breaker Press. Switch =  Travel Alarm Select Switch

=  Pattern Change(ISO)

3) Solenoid Valve: You can check the status of the solenoid valve
=  Breaker Operating S/V . High Speed S/V
= Relief Pressure Up S/V . Negacon Cut S/V
= 2 Pump Select S/V

4) Relay: You can check the status of the vehicle relay

=  Starter Relay, . Backup Alarm Relay

¢+ Crawler Excavator(30 ton)

1) Digital Input: You can check the status of the vehicle

= Alternator, =  Return Filter,
= Air Cleaner Indicator, =  Water in Fuel,
= Pilot Filter, =  TMS Status,
2) Switch: You can check the status of the user's operation
=  Power Max =  OWD Select Switch
=  Breaker Operating *= Pedal Breaker Press. Switch,
= High Speed Select(Manual) =  Pattern Change(ISO)
= High Speed Select(Auto) =  Pattern Change(BHL)
=  Working Lamp =  Swing Press. Switch
=  Quick Clamp =  Preheat
= Aircon Switch =  Starter Switch
=  One Touch Decel. Switch =  Swing Alarm Select Switch
= Intelligent Boom Switch =  Travel Alarm Select Switch

] Pilot Cut Off



3) Solenoid Valve: You can check the status of the solenoid valve
=  Breaker Operating S/V . High Speed S/V
*» Relief Pressure Up S/V . Negacon Cut S/V
= 2 Pump Select S/V

4) Relay: You can check the status of the vehicle relay

»=  Starter Relay . Backup Alarm Relay

¢ Crawler Excavator(30 ton~)

1) Digital Input: You can check the status of the vehicle

= Digital Input . Return Filter
= Alternator =  Water in Fuel
= Air Cleaner Indicator . TMS Status

= Pilot Filter

2) Switch: You can check the status of the user's operation

=  Power Max =  OWD Select Switch

=  Breaker Operating =  Pedal Breaker Press. Switch
=  High Speed Select(Manual) . Pattern Change(ISO)

= High Speed Select(Auto) . Pattern Change(BHL)

= Working Lamp =  Swing Press. Switch

= Quick Clamp . Preheat,

= Aircon Switch = Starter Switch

=  One Touch Decel. Switch =  Swing Alarm Select Switch

= Intelligent Boom Switch =  Travel Alarm Select Switch

=  Pilot Cut Off

3) Solenoid Valve: You can check the status of the solenoid valve
=  Breaker Operating S/V = Reverse Fan S/V
= Relief Pressure Up S/V = 2 Pump Select S/V
=  High Speed S/V

4) Relay: You can check the status of the vehicle relay

=  Starter Relay . Backup Alarm Relay



¢ Crawler Excavator(VBO, 34/38 ton)

1) Digital Input: You can check the status of the vehicle

= Alternator . Return Filter
=  Air Cleaner Indicator . Water in Fuel
. Pilot Filter . TMS Status

2) Switch: You can check the status of the user's operation

=  Power Max = OWD Select Switch

=  Breaker Operating * Pedal Breaker Press. Switch
= High Speed Select(Manual) = Pattern Change(ISO)

= High Speed Select(Auto) = Pattern Change(BHL)

=  Working Lamp *= Swing Press. Switch

= Quick Clamp * Preheat

= Aircon Switch = Starter Switch

= One Touch Decel. Switch, *= Swing Alarm Select Switch

= Intelligent Boom Switch = Travel Alarm Select Switch

=  Pilot Cut Off

3) Solenoid Valve: You can check the status of the solenoid valve
=  Breaker Operating S/V = Bypass Cut Off S/V
=  High Speed S/V * Swing Brake Release S/V

4) Relay: You can check the status of the vehicle relay

»=  Starter Relay = Backup Alarm Relay

¢ Wheel Excavator

1) Digital Input: You can check the status of the vehicle

= Alternator = Return Filter
= Air Cleaner Indicator =  Water in Fuel
. Pilot Filter = TMS Status

2) Switch: You can check the status of the user's operation

=  Power Max =  Forward Switch

= Breaker Operating = Neutral Switch

= Travel Select = Reverse Switch

= Working Lamp =  Cruise Select Switch

Quick Clamp = Stop Lamp Switch



Inching Speed Select Switch,
Low Speed Select Switch

High Speed Select Switch

High Beam Select Switch
Emergency Steering Press. Sw
Aircon Switch

Parking Switch

Ram Lock Switch

One Touch Decel. Switch

Intelligent Boom Switch

Pilot Cut Off

OWD Select Switch

Brake Oil Press. Switch
Pedal Breaker Press. Switch
Accel Pedal Validation Switch
Pattern Change(ISO)

Pattern Change(BHL)
Preheat, Starter Switch

Travel Alarm Select Switch

3) Solenoid Valve: You can check the status of the solenoid valve

Breaker Operating S/V
Relief Pressure Up S/V
2 Pump Select S/V
Cruise S/V

Forward S/V
Reverse S/V
Negacon Cut S/V

4) Relay: You can check the status of the vehicle relay

Starter Relay
Backup Alarm Relay
Backup Lamp Relay

Wheel Loader — Doosan Engine

Inching Speed Relay
Low Speed Relay
High Speed Relay

1) Digital Input: You can check the status of the vehicle

Boom Magnet

Pilot Buzzer

2) Switch: You can check the status of the user's operation

Reverse Fan Switch(Manual)
Reverse Fan Switch(Auto),
Aircon Switch,

Safety Start Switch,

Detent Set Switch (BOOM),
Detent Active Switch,

VCCO Select Switch,

Pilot Cut Off Switch,

Engine Mode Switch(L),

Parking  Brake  Pressure
Switch,

Engine Mode Switch(M),
VCCO Set Switch,
Accel Pedal Validation Switch,
Power Mode Foot Switch
Transmission Shift Switch(L),
Transmission Shift Switch(M),

Quick Clamp Switch



3) Solenoid Valve: You can check the status of the solenoid valve

= Reverse Fan Solenoid Valve * Unloading Solenoid Valve

4) Relay: You can check the status of the vehicle relay

=  Starter Relay

¢ Wheel Loader — Scania Engine
1) Digital Input: You can check the status of the vehicle
=  Boom Magnet * Pilot Buzzer

=  Bucket Magnet

2) Switch: You can check the status of the user's operation

=  Electric Steering Select Switch, = Key Switch(Start)

=  Electric Steering Speed High Switch, = Parking Brake Pressure Switch
=  Electric Steering Direction Switch, *= Engine Mode Switch(M)

*= Reverse Fan Switch(Manual), = Torque Converter Lock Up S/W
= Reverse Fan Switch(Auto), = VCCO Set Switch

= Aircon Switch, » Accel Pedal Validation Switch

»  Safety Start Switch, = 3rd FNR (F)

=  Arm Rest Cut Off Switch, = 3rd FNR (N)

=  Detent Set Switch (BOOM), = 3rd FNR (R)

=  Detent Set Switch (Bucket), . Power Mode Foot Switch

= Detent Active Switch, = Transmission Shift Switch(L)
=  VCCO Select Switch = Transmission Shift Switch(M)
= Engine Mode Switch(L) *=  Quick Clamp Switch

3) Solenoid Valve: You can check the status of the solenoid valve

= Reverse Fan Solenoid Valve * Unloading Solenoid Valve

Note) The data displayed on the screen can be different, depending on the model.
Please refer to the equipment specification.



5.3 Analog In/Out

4 Use this function to check various data related to an excavator/wheel Loader
in real time.

1. Double click [Monitoring] — [Analog In-Out] on the workspace window of the DMS
main screen.

DX300LC-3 - [Analog In-0Out]
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The data displayed on the screen can be different, depending on the
excavator/wheel loader model.

2. You can check the following data on this window.

¢ Crawler Excavator(14~30 ton)

=  Pilot Pressure(Work) * Pressure Control P/V1

= Pilot Pressure(Travel) * Pressure Control P/V2

= Two-way P/V (open) = Alternator Voltage

=  Two way P/V (closed) = Lh Thumb Wheel Voltage
= Rotating P/V (CW) » Rh Thumb Wheel Voltage

= Rotating P/V (CCW)

¢ Crawler Excavator(30ton)

= Pilot Pressure(Work) =  Pressure Control P/V1

* Pilot Pressure(Travel) =  Pressure Control P/V2

=  Two-way P/V (open) = Alternator Voltage

=  Two way P/V (closed) =  Lh Thumb Wheel Voltage

* Rotating P/V (CW)
* Rotating P/V (CCW)

Rh Thumb Wheel Voltage



¢ Crawler Excavator(30 ton~)

¢ Crawler Excavator(VBO, 34/38 ton)

Pilot Pressure(Work)
Pilot Pressure(Travel)
Two-way P/V (open)
Two way P/V (closed)
Rotating P/V (CW)
Rotating P/V (CCW)

Two-way P/V (open)
Two way P/V (closed)
Rotating P/V (CW)
Rotating P/V (CCW)
Pressure Control P/V1
Pressure Control P/V2

¢ Wheel Excavator

¢ Wheel Loader — Doosan Engine

Pilot Pressure(Work)
Pilot Pressure(Travel)
Two-way P/V (open)
Two way P/V (closed)
Rotating P/V (CW)
Rotating P/V (CCW)

Break Oil Pressure
Main Pressure
Water In Fuel

Angle Sensor Boom

Alternator

Pressure Control P/V1
Pressure Control P/V2
Alternator Voltage

Lh Thumb Wheel Voltage
Rh Thumb Wheel Voltage

Front pump Angle volt
Rear pump Angle volt
Travel Straight P/V
Alternator Voltage
Lh Thumb Wheel Voltage
Rh Thumb Wheel Voltage

Pressure Control P/V1
Pressure Control P/V2
Alternator Voltage

Lh Thumb Wheel Voltage
Rh Thumb Wheel Voltage
Speed Meter

Accel Pedal
Battery
Fan Control Solenoid Valve

Fuel Level



¢ Wheel Loader — Scania Engine

=  Break Oil Pressure = Main Pressure

=  Steer Pressure = Accel Pedal

=  Water In Fuel = Battery

. Angle Sensor Boom = Fan Control P/V
=  Angle Sensor Bucket =  Fuel Level

. Alternator

Note) The data displayed on the screen can be different, depending on the model.
Please refer to the equipment specification.



5.4 VBOJ/Elec. Pump

4 Use this function to check various data related to an excavator in real time.

1. Double click [Monitoring] — [VBO/Electronic Pump] on the workspace window of the

DMS main screen.

DX380L.C-3 - [VBO/Electronic Pump]
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You can see the following data on this window.
: You can check the analog output status of VBO equipment.

=  Boom up pressure

=  Boom down pressure

=  Bucket crowd pressure
=  Bucket dump pressure
= Arm in pressure

=  Arm out pressure

=  Front pump angle volt

= Rear pump angle volt

L A—
T ™ 10 ©° 1 °© [ o I I ] ! ' [ ' [ '
0 2000 4000 i 2000 4000 ] 20 40 1] 2 40
2520 2490 my 0 Bar 0 Bar
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Swing pressure
Swing pressure
Front pump pressure
Rear pump pressure

Pump control P/V

Pump control P/V — electronic

Travel right pressure

Travel left pressure

Note) The VBO/Electronic Pump menu is activated for the DX350LC-3 and DX380LC-3
model only.



5.5 Transmission

4 Use this function to check various data related to a wheel loader.

1.

Select [View] — [Monitoring] menu on the DMS main screen, or double click
[Monitoring] — [Transmission] on the workspace window.

DL350-3 - [Transmission] SO
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2.

You can see the following data on this screen.

€ Wheel Loader(Doosan E/G)
1) Sensor Data

2) State

3) Switch

4) Relay

Torque Converter Oil Temp.

Sump Oil Temp.

Transmission Mode
Current Direction

Select Direction

LIS Switch

Parking Brake Release
Switch

FNR 2nd Select Switch

Back Up Relay

Output Shaft Speed
Brake Pedal Voltage

Differential Lock Engaged
FNR 2nd Gear Engaged
Vehicle Clutch Cut Off

Differential Lock Auto Switch

Differential Lock Manual
Switch

Select Gear

LIS Relay




€ Wheel Loader(Scania E/G)

1) Sensor Data

= Torque Converter Oil Temp. = Output Shaft Speed
= Sump Oil Temp. =  Brake Pedal Voltage
2) State
=  Auto Transmission Mode = Torque Cvt Lock Up Engaged
=  Current Gear = FNR 2nd Gear Engaged
=  Select Gear = FNR 3nd Gear Engaged
= Differential Lock Engaged = Vehicle Clutch Cut Off
3) Switch
= LIS Switch = Differential Lock Manual
=  Parking Brake Release Switch
Switch =  Select Gear
=  FNR 2nd Select Switch = Clutch Cut Off
= Differential Lock Auto Switch
4) Relay
= Back Up Relay = LIS Relay

Note) The data displayed on the screen can be different, depending on the model.
Please refer to the equipment specification.



5.6 Elec. MCV

4 Use this function to check various data related to a wheel loader.

1. Select [View] — [Monitoring] menu on the DMS main screen, or double
[Monitoring] — [Elec MCV] on the workspace window.

- DL550-3 (eMCV) - [Elec MCV] E)&

E_Ei\e Miew Connect Tools MWindow Help -8 x
= ? % ]

x =]

EMCY
EMCY P/¥ Float

= B Monitoring EMCY IV Raise
1 Basic ] e
0 200 400 0D 60D 0 200 400 600 600

2 Digital In-Out 263 mA 263 mA

3 Analog In-0ut

4 Elec MCY

EMCY Pj¥ Dump EMCY Py Crowd

[ Engine Characteristics

Electric Steering

Electric Steering Valve {Left)

Lo
o 50 100
4.29497e+0 %

Elechric Steering Vakve (Right)

A . S . ¢
[ [ ] i | '’ ] !
5 Transmission 0 200 400 00 800 0 200 400 &00 800 1) 50 100
264 mi 264 mit 4,23497e+0 %

[ EMCY Pj¥ Option1 EMCY P OptionZ Value State
n Graph Output
\BE Braph Sup Blacked
T 4 S ¢
P ﬂ;] Force Operation o a0 40 e eo o a0 a0 e e
Lo e i Electric Stesring Lever
= . ’ m m
‘/3 Diagnosis 10020003000 400
0 5000
i | History Data EMCY Lever Boom EMCY Lewer Bucket EMCY Lever Option
@ Parameter 5000 5000 5000
© 4000 4000 4000 200 mit
000 000 000
000 000 am} | Electric Steering Select Switch
1000 1000 1000
@ o @ Bl Etechric Steering Speed High Switch
696 my 310 mv 921 mv

. Electric Steering Direction Switch

@@ NUM

2. You can see the following data on this screen.

5) EMCV
= EMCV Lever Boom,

= EMCV Lever Bucket,
= EMCV Lever Option,
= EMCV P/V Float,
= EMCV P/V Raise,

2) Electric Steering

= Electric Steering Valve (Left),
= Electric Steering Valve (Right)
* Value State

» Electric Steering Lever

= Electric

= EMCV P/V Dump,
= EMCV P/V Crowd,
= EMCV P/V Optionl,
= EMCV P/V Option2

= Electric Steering Select Switch

Steering Speed High
Switch

= Electric Steering Direction Switch

Note) The data displayed on the screen can be different, depending on the model.

Please refer to the equipment specification.



5.7 Engine Property

4 Use this function to check various data related to an excavator/wheel loader in
real time.

1. Double click [Monitoring] — [Engine Characteristics] on the workspace window of the
DMS main screen.

DX140W-3 - [Engine Characteristics] BEm
|# File View Connect Tools Window Help -3 x
=] ? b4 [ ]
5 =
Throttle Position Percent Load st Current Speed Fuel Temp, Engine Ol Temp.
= B Monttoring = . < 2
. 40 il 80
20 @ 0 80 0 100
1 Basic a 10 P g 120 00— 100~
2 Digital In-Out
3 Analog In-Ou 52.4 % 0% 3 =
4 WBO/Electron Fuel Rate Accel pedal position
" 60 80 100 30 40 50 60 79 0
5 Engine Chard &M 120 3 -
— o o 100
Graph Dutput
, Intake Manfold Temp, Conlant Water Temp
Force Operation
Uﬂ " 0.0 th 2%
ey
/ Diagnasis o] L0 ]
pE Fan Speed Eoost Pressure Engine Ol Pressure
Higtory Data
5 v L L — L S
o oo o 50— 50
@ Paramneter o 10000 2000 3000 0 S 10 0 B 10
B 0 rpm 1.4 Bar 1.4 Bar
L~ 0
DOC Intake Temp. DOC Outlet Temp. 24 C 79 ©
150 [ -40 [
DPF Pressure DPF Outlet Termp. Tokal Fuel Used
6.50 &S 100 |ed
< 2]
X hM

2. You can check the following data on this window.

¢ Crawler Excavator(14~30 ton)

= Accel pedal position

= Throttle Position

= Percent Load at Current Speed

* Fuel Rate

= Fan Speed

= Boost Pressure

= Engine Oil Pressure

= Fuel Temp.

Engine Oil Temp.
Coolant Water Temp,
Intake Manifold Temp.
DOC Intake Temp.
DOC Outlet Temp.
DPF Outlet Temp.
DPF Pressure

Total Fuel Used



¢ Crawler Excavator(30 ton)

Accel pedal position

Throttle Position

Percent Load at Current Speed
Fuel Rate

Fan Speed

Boost Pressure

Engine Oil Pressure

Fuel Temp.

¢ Crawler Excavator(30 ton~)

¢ Crawler Excavator(VBO, 34/38 ton)

Fuel Rate

Boost Pressure
Engine Oil Pressure
Fuel Temp.

Engine Oil Temp.

Coolant Water Temp.

Accel pedal position

Throttle Position

Percent Load at Current Speed
Fuel Rate

Fan Speed

Boost Pressure

Engine Oil Pressure

Fuel Temp.

Engine Oil Temp.
Coolant Water Temp.
Intake Manifold Temp.
DOC Intake Temp.
DOC Outlet Temp
DPF Outlet Temp.
DPF Pressure

Total Fuel Used

Intake Manifold Temp.
DOC Intake Temp.
DOC Outlet Temp.
DPF Pressure

Total Fuel Used

Engine Oil Temp.
Coolant Water Temp.
Intake Manifold Temp.
DOC Intake Temp.
DOC Outlet Temp.
DPF Outlet Temp.
DPF Pressure

Total Fuel Used



¢+ Wheel Excavator

Accel pedal position

Throttle Position

Percent Load at Current Speed
Fuel Rate

Fan Speed

Boost Pressure

Engine Oil Pressure

Fuel Temp.

¢ Wheel Loader — Doosan Engine

Engine Speed

Throttle Position

Percent Load at current Speed
Fuel Rate

Boost Pressure

Engine Oil Pressure

Fuel Temp.

Engine Oil Temp.

Coolant Temp.

Intake Manifold Temp.

<EGR>

DOC Intake Temperature
DOC Outlet Temperature

<Warning>

Engine
Engine Oil Pressure
Engine Stop

Preheat

Engine Oil Temp.
Coolant Water Temp.
Intake Manifold Temp.
DOC Intake Temp.
DOC Outlet Temp.
DPF Outlet Temp.
DPF Pressure

Total Fuel Used

Accel Pedal Position
Total Fuel Used

Total Fuel Used(M)
Percent Torque
Reference Torque
Forced Regen Status
Eco Level

Pilot Cut Off Switch

Parking Brake Pressure Switch

DPF Outlet Temperature
DPF Pressure

DPF
HEST
Prohibit Regen



¢ Wheel Loader — Scania Engine

Engine Speed

Percent Load at current Speed
Fuel Rate

Boost Pressure

Engine Oil Pressure

Coolant Temp.

Intake Manifold Temp.

Accel Pedal Position

<Warning>

Note) The data displayed on the screen can
Please refer to the equipment specification.

Engine

Engine Oil Pressure

=  Total Fuel Used

=  Total Fuel Used (M)
=  Percent Torque

= Reference Torque

= DEF(AdBLue) Level
=  Accel Pedal

= Low ldle Switch

. Eco Level

» DEF(AdBLue) Low
SCR Fault

be different, depending on the model.



6 Graph output

4 The function provides plotted sensor data related with excavator/wheel
loader performance in graphs and can save the measured data in a hard disc.
It also enables to evaluate the performance of excavators by comparison and

analysis of the measured data.

m The following data is used.

€ Excavator

Engine Speed

Throttle Position

Percent Load at Current Speed
Fuel Rate

Boost Pressure

Engine Oil Pressure

Fuel Temp.

Engine Oil Temp.
Coolant Water Temp.
DOC Intake Temperature
DOC Outlet Temperature
DPF Outlet Temperature
DPF Pressure

Fan Speed

Intake Manifold Temp
Total Fuel Consumption
Acceleration Pedal Position
Front Pump pressure
Rear Pump pressure
Boom Pressure

Px Pressure

Py Pressure

Parking Break pressure (Pilot gear

Pump Pressure)
Alternator Voltage
Battery Voltage

Engine Control Dial

TMS Voltage

Water in Fuel Sensor

Lh Thumb Wheel Voltage
Rh Thumb Wheel Voltage
Operating Oil Temperature
Vehicle Speed (Real)
Vehicle Speed

Power Shift 1 P/V

Power Shift 2 P/V

Flow Control P/V
Two-way P/V (open)

Two way P/V (closed)
Rotating P/V (CW)
Rotating P/V (CCW)
Pressure Control P/V1
Pressure Control P/V2
Boom Up Pressure
Boom Down Pressure
Arm Crowd Pressure
Arm Dump Pressure
Bucket Crowd Pressure
Bucket Dump Pressure
Swing Pressure

Front Pump Pressure
Rear Pump Pressure
Travel Straight P/V



€ Wheel Loader

Engine Speed

Throttle Position

Percent Load at Current Speed

Fuel Rate

Boost Pressure

Engine Oil Pressure

Fuel Temp.

Engine Oil Temp.
Coolant Water Temp.
DOC Intake Temperature
DOC Outlet Temperature
DPF Outlet Temperature
DPF Pressure
Acceleration Pedal Position
Intake Manifold Temp
Total Fuel Consumption
Percent Torque
Reference Torque
Torque Converter Oil Temp
Sump Oil Temp

Brake Pedal Voltage
Estimated Flow_Extend
Estimated Flow_Retract
Vehicle Speed

ECO Level Percent

Brake Oil Pressure

Main Pressure

Steer pressure

Angle Sensor Boom
Angle Sensor Bucket
Electric Steer Joystick
EMCV Joystick Boom
EMCV Joystick Bucket
EMCV Joystick Option(3')
Alternator

Battery Voltage

EMCYV P/V Float

EMCV P/V Raise

EMCV P/V Dump

EMCV P/V Crowd

EMCV P/V 3rd UP

EMCV P/V 3rd Down
Cooling Fan Control P/V
Reverse Fan Solenoid Valve
Unloading Solenoid Valve
Starter Relay

Boom Magnet

Bucket Magnet



1.

Select [View] — [Graph Output] from the DMS main screen, or double click [Graph
Output] on the workspace window.
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Zoom In: The monitoring graph display will be expanded.

Zoom out: The monitoring graph display will be shrunk.

Move: The monitoring graph display will be moved up/down/left/right.
Grid X: A grid line will be displayed to the X axis.

Grid Y: A grid line will be displayed to the Y axis.

Graph XY: Relation will be displayed using the monitored data.
Print: A graph screen will be printed out.

CSNONCNONONONC)

2. Select [Connect]-[Connect] menu or click the % (Connect icon) icon and B
(Start monitoring icon) to display a graph on the DMS screen.

3. The monitoring cycle is 20ms.
(If monitoring-related windows are opened on the DMS screen, besides the graph,
the monitoring cycle will be changed to 100ms.)



4. If you right click on the window that shows the data type, you can modify several data.
(When graph display is stopped ( H ))

D255LC-3 AEE
Eile Wiew Connect Graph Tools Mindow Help

=Ed g9 %

{£ Graph Output

EEX

= B Monitoring T
= == i
‘ A=l A
1 Basic L
2 Digital In-Out
3 Analag In-Out Il rosirate 2200
[ Engine Oi Pressure
41 VBO/Electranic Pump Fuel Temp. 2000 —

B Engre Oi Termp,

1800~
. Conlant Water Temp.

5 Engine Characteristics

@ Graph Output . Fan Speed 1600~
b [ Intake Marifald Temp g
h ﬂ Force Operation I+, 0 Temp. 400
L7 §1
\.1 Diagnosis T
- @
|k | History Data S:f‘:;ﬂ‘:ﬂg Stooo~
B00—
@ parametr Remove Dat

Show selected data in bold
Disables the unselected data
Show selected data only

Show Y-axis
Hide Y-axis

Ready

1) Add Data: You can select the data using the [Select All], [Select None], [Select Reverse]
button on the “Select Data” window.

select Data E|

IEI- Engine Spee ~

- Throttle Position

- Percent Load at Current Speed Eancel
- Fuel Rate

Boost Pressure Select Al
- Engine Qil Pressure

Fuel Ternp. Select None

- Engine Qil Terp.
- Coolant Water Ternp. =
- DoOC Intake Terp.
DOC Qutlet Terp,
B orF outlet Temp.
- DPF Pressure
- Fan Speed

- Intake Manifold Ternp

- Total Fuel Consurnption

- Acceleration Pedal Position

- Frant Purnp pressure

[ rear Pump pressure b

Select Reverse

| .................... v| [Setl.“:mup Dala]

[ Sawve Current List Az Mew Group ] [ Delete Group ]

@® OK: Click [OK] to select the data after modification.
® Cancel: Click this button to cancel data selection
® Select All: Click this button to select all data.



@ Select None: Click this button to unselect all data.

® Select Reverse: Click this button to reverse the data selection status. Selection will be
cancelled, and the unselected data will be selected.

Note 1) Up to 10 data can be monitored on graph display.

|"'_~, baximurm number of monitor data i 10,
L]

2) Graph Property Setting: You can modify Scale, Offset, and Color.
@® Modifying Scale and Offset

= You can see that Engine Oil pressure is 6.1 Bar on graph display.
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®@ When you open the “Graph Property Setting” window with right mouse click, change the
Scale and Offset as shown below and click [OK].

Graph Property Setting [X|

Mama Scala Dffzat Caolor

Ergine Oil Pressure 1.30 1.00 - ]

® You can see that Engine Oile Pressure is 8.9 Bar, as shown in the figure.
(Engine Oil Pressure * Scale + Offset = Modified Engine Oil pressure)
>6.1*13+1=8.9
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@ Changing Color

= Click the Color column in the “Graph Property Setting” window and select the color to
change and then, click [OK].

Graph Property Setting

3
o |

Mame Scale Offset Color
Engine Speed 1.00 0.00 I
Coolant Water Termp. 1.00 0.00 I
acceleration Pedal Position 1.00 0.00 -
Front PUmp pressure 1.00 0.00 -
Rear PUmmp pressure 1.00 0.00 -
Px Pressure 1.00 0.00 -
alrernator Voltage 1.00 0.00 -
Battery Voltage 1.00 0.00 -
Engine Control Dial 1.00 0.00 -
Operating Ol Temperature 1.00 0.00 -

[ AHETHAE A BEETID) > |

T R

3) Remove Data: The data displayed on the DMS screen will be removed.

[~ I Engine Speed . Engine Speed
. Coolant Water Temp. 2400
[ Acceleration Pedal Position . Coolant Water Te mp.
. Front Pump pressure 2200 . -
[0 Rear pump pressure . Acceleration Pedal Position
. Px Pressure 2000
Bl Aremator votage . Front Pump pressure
. Battery Voltage 1800 .
. Engine Control Dial Rear pl..lm]:l pressure
" el BRTE
B P pressure
Data Confi
s . Alternator Voltage
Femave Data
Show selected data in bold . Batter'rr VEI"]QE
Disables the unselected data : : I
Show selected data only Dl | Erlf-_]lrle Cc’ntrﬂ‘l D‘El i
Show Y-axis I I
Hide V-axis

[Before data removal] [After data removal]



4) Show selected data in bold: Only the selected data will be displayed in bold fonts.
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6) Show selected data only: Only the selected data will be displayed, and the remaining
data will be hidden.

Note) When the graph display window is opened ( B ), only (Show selected data in
bold, Disable unselected data, Show selected data only) will be applied.
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7) Show Y-axis

Example) If you select the “Engine Speed” checkbox and select the “Show Y-axis” menu, the
Engine RPM will be displayed on the Y axis of the graph, as shown below.

< DX255L.C-3
FElle Mew Connect Graph Toolz Window Help

=EH &% =

[* Graph Output

K Xly e a B

g Monitoring

[
‘_E Graph Qutput

o [T W Erare speed 1797.0 —
!,H Force Operation . Percent Load at Curren 32,0 120 2400
"’:, Diagnosis B Fusl Rate 7.4 I —
- . Engine Cil Pressure 61
Ve, Histary Data . Engine Oil Temp. 49.6 100} 2000
@ Paramater . Coolant Water Temp.  53.0 ) —
[ Fan Speed 266.0

@
=}
T

I IZ| |H'-;'|:I. Oil Temp. 600~

-
=)
T

«
=]
T
Engine Speed (rpm )
o o=
& 2 =
2 2 =8
1 | 1

Percent Load at Current Speed (%)

sof

sl @00

s} e . ot + M r

20 o0

1o} 200

o 0 T T T T T i
[Time 0.0 b 5 10 15 20

Time (sec)

Ready ool MU




7) Hide Y-axis
Example) If you select the “Engine Speed” checkbox and select the “Hide Y-axis” menu, the
Engine RPM will be hidden from the Y axis of the graph, as shown below.
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5. The following section describes icons on the graph.

~ - DX255LC-3

=H &% =

|
E Graph Output

b‘ﬂ Force Operation
=

File View Connect Graph Tools Window Help

! Maonitoring

I# Granh Mudnut

T
SN I SpE 1ouLU

Time 6.7 At8.3

. Percent Loat 31.0 10 1204
o/ Diagnosis Wrerste 75 0z e
= [0 Engine Gl Fr 6.1 0o
Ve | History Data I Engine 0l Te 4.5 0z 100~
@ P aramater B comantwatsao oo Fa
W Fanspesd 3000 180 <
B Hyd. il Terr 0.0 0o & 80
&
§ -
3
5 B0—
5
3
S 59—
E
£ 40—
&
30— w
20—

10
Time (sec)

Ready

& @

MUk

1) Time 6.7 At8.3" shows the time difference in the graph.



2) Each time you click [Alt + data name] with your left mouse button, the data name and
scope will be created on the Y axis of the graph screen.
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Move the output data to the left/right (Zooming in/out is applicable for
the left and right only.)

I><

Move the output data up/down (Zooming in/out is applicable for up
and down movement only.)

A—
-

Move the output data to the up/down/left/right direction (Zooming
infout is applicable for up/down/left/right movement.)

Ix
®\ ' Increase the image size of the output data.

Decrease the image size of the output data.

Expand the selected area.

Move to the previous step of graph display.

* Needed to move the output data to the up/down/left/right direction.
>
L '

Move to the next step of graph display.

Check the position value of the output data.

Check the time value in the output data selection area.




-_— Y-axis grid (A Y-axis will be created for each data.)

X-axis grid

Move to the beginning of the output data.

Move to the previous step of the output data.

Move to the next step of the output data.

YV V A A

Move to the end of the output data.

3) : The name of the graph selected from the left side list will be selected, if the graph
line is selected from the graph screen after logging.

When selected, the name of the selected graph, and X and Y value will be displayed on the
bottom selection window.
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’1;-\!
4) : Data relations can be checked, using the monitored data.
® Monitor the data and click the XY Chart icon.
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@ Select the data to display on the screen from the monitored data items, and click the “Draw
Graph” button. If monitoring is in progress, the graph will be updated continuously.

Note 1) If you monitor the XY graph for along time, the program can be slowed down.
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5)

: The displayed graph will be printed out.

Click the Print icon, set the printer, and click the [OK] button.
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6. When printing out the graph, the [Export, Import] menu will be created under the File menu.

DX255LC-3
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1) Export: The graph output data can be saved as a (.csv) file.
@ Select [File]-[Export] menu. The data cannot be saved while the data is received.)

R AR [ U-Model DMS =] o B~
Y I DonsanPrograrnrmer
4 =dava
W= SN [EraphOata cov
=
L
HHEF St
=)
L 24
B =ES
Lf LIEST 22
o 120N |GraphData‘csv Ll | HEHE)
IH P A(TH |CEY File (ncsv) k3| e

When a [Save As...] dialog box appear, select the driver and folder to save the file, or type
the saving location in “Save in”".

Select a folder to save the file.

Input the name of the file to save in “File name” and click the [Save] button.
The file extension is (.csv).

When the “Export” dialog box appeatr, select the data to export and click [OK].

@ 6

selec] name Export Name

Engine Speed

Percent Load at Current Speed
Fuel Rate

Engine Oil Pressure

Fuel Temp.

Engine il Temp.

Coolant Water Temp,

Fan Speed

Intake Manifold Temp

Hyd, Oil Temp.

Engine Speed

Percent Load at Current Speed
Fuel Rate

Engine Oil Pressure

Fuel Temp.

Engine il Temp.,

Coolant Water Temp,

Fan Speed
Intake Manifold Temp
Hyd, Qil Temp.

Cencel

Select Al
Select None




2) Import: The graph data save din the (.csv) file can be fetched.

@ Select [File]-[Import].

® When the [Open] dialog box appear, select the file (.csv) to import and click the [Open]

button.
291
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W} UESS 22
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name
Engine Speed
Percent Load at Current Speed
Fuel Rate
Engine Oil Pressure
Fuel Temp,
Engine il Temp.
Coolant Water Temp.
Fan Speed
Intake Manifold Temp
Hyd. Gil Temp.

Export Name
Engine Speed
Percent Load at Current Speed
Fuel Rate
Engine il Pressure
Fuel Temp,
Engine il Temp,

Conolant Water Temp.

Fan Speed
Intake Manifold Temp
Hyd. il Temp.

3) If you open the CSV file, the saved data will be displayed as shown below.
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6 | 0.067709 2001 2 294 1] 30 7 2711 1022 86
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8 | 0108421 2001 92 294 o 0 271 271 1025 85
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22 | 0386407 2001 92 294 ] 30 27 271 1024 85
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7 Force Operation

4 Use this function to start the Controller (EPOS/VCU) by force. You can

implement the situation artificially that cannot be realized in actual equipment,
using this function.

m Force Operation

1. Select [View] — [Force Operation] menu on the DMS main screen, or double click
[Force Operation] on the workspace window.

D140
Connect Sefings  Tools  Window Help
Manitoring [N
Gitaph Ourout
Force Operation
x
Dizgnosis —

History Data
Parameter

v Workspace

Toolbar
v Statusbar out

ut

4 VBO/Electronic Pump

5  Engine Characteristics

B3 soon oupun
(Vg
1

Force Operation
gk

@ ;&'4 History Data

@ Parameter

2. If you run the “Force Operation” menu, the following “Enter Password” window will
appear as shown below.

Enter Password

Enter Password, ek Ok [ Cancel ]

Note) You should input the password to start “force operation” because it requires
your attention.



3. The following “Force Operation” window will appear, if you input the correct password
and click the [OK] button.
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| o[ |_oft | apely ]

=

4.  You can check the graph output data that is started by force, as shown below.
Ex) Output data graph when applying the force operation by setting the "Engine RPM
Command" to 50%

1) Click the [On] button of the item to start by force.
2) Set value and click the [Apply] button to operate by force selectively.
3) Click the [Off] button to stop force operation.
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5. The following force operation items are provided.

€ Crawler Excavator (14~30 ton)

€ Crawler Excavator (30 ton)

Power Shift P/V
Coolant Fan Clutch
Flow Control P/V

Engine RPM Command

Starter Relay
Negacon Cut S/V

Power Shift P/V
Coolant Fan Clutch
Flow Control P/V
Engine RPM Command
Starter Relay

Negacon Cut S/V

Crawler Excavator (VBO, 34/38ton)

Power Shift 1 P/V
Power Shift 2 P/V
Coolant Fan Clutch
Travel Straight P/V
Engine RPM Command

Swing Brake Release S/V

Crawler Excavator (30ton~)

Power Shift 1 P/V
Coolant Fan Clutch
Flow Control P/V
Engine RPM Command
Starter Relay

Reversed S/V

2Pump Select S/V
High Speed S/V
Power Max S/V
Breaker Operation S/V
Backup Alarm Relay

2Pump Select S/V
High Speed S/V
Power Max S/V
Breaker Operation S/V
Backup Alarm Relay

Bypass Cut Off S/V
Starter Relay

2Pump Select SIV
High Speed S/V
Breaker Operation S/V
Backup Alarm Relay

2Pump Select S/V
High Speed S/V
Power Max S/V
Breaker Operation S/V
Backup Alarm Relay



€ Wheel Excavator

= Power Shift 1 P/V = 2Pump Select S/V

= Coolant Fan Clutch * Inching Relay

= Flow Control P/V = Power Max S/V

= Engine RPM Command = Breaker Operation S/V
= Negacon Cut S/V = Low Speed Relay

= Starter Relay = Backup Alarm Relay

= High Speed Relay = Backup Lamp Relay

= Reversed S/V = Cruise S/V

= Forward S/V

€ Wheel Loader (Doosan E/G)

= Fan Control P/V = Boom Magnet
= Engine RPM Command = Bucket Magnet
= Starter Relay = Unloading S/V

= Reverse Fan S/V

€ Wheel Loader (Scania E/G)

= Fan Control P/V = EMCV P/V Float

= Engine RPM Command = EMCV P/V Raise

= Reverse Fan S/V = EMCV P/ Dump

= Boom Magnet = EMCV P/V Crowd
* Bucket Magnet = EMCYV P/V Optionl
= Unloading S/V = EMCV P/V Option2

= Engine Start



8 Diagnosis

4 Use this function to check the current and past malfunction history of the
controller (EPOS/VCU).

H Current Diagnostic View

1. Double click [Diagnosis] on the workspace window of the DMS main screen.

. DX300LC-3 - [Diagnosis]

“:'1' File ¥iew Connect Tools Window Help -8 X%
Fd &% 5
X || Current Diagnostic Visw s
_ Monatoring
. efresh
‘I! Graph autput v
> H Force Operation Failure Histary
;d;:? Diagnosis ‘
ERS % Histary Management No Code 7 Count Failure Time Error Information FMI Infomation
OO || NI vooczis 2 | 0hiom[FANCONTROLPNUI  Cumentbelownomal
2 V000237 1 Oh 32m FRONT PUMP PRESS. SENSO Voltage above normal
2 Qperation Time 3 Yoooz3z 1 0h 31m BYPASS CUT OFF SV [J] Current below normal
4 vooo2z2o 1 0h 31m TRAVEL STRAIGHT PV (L) Current below normal
3 Fiteril nfo 5 V000237 3 Oh31m  FRONT PUMP PRESS. SENSO Incorrect signal
4 Daily Operation Info 6 voooz01 1 Oh 31m GAUGE PANEL ERROR Failure mode not identifiable
p 7 E000157 1 Oh Om CP metering unit Current below normal
@ Patamater Modification 8 | E520642 1 oh Om ECU shut off path error Failed
9 |Eb20628 1 Oh Om MU Hyrocarbon dosing valve Voltage above normal
10 EDDOOS1 2 Oh Om Throttle valve postion sensor Voltage above normal
11 EDD3242 1 Oh Om DPF upstream temperature  Voltage above normal
12 |EDO0129 1 Oh Om Rail pressure sensor VYoltage above normal
13 EDOO110 1 Oh Om Coolant temperature Voltage above normal
14 |E520631 1 Oh Om MU downstream pressure sen Voltage above normal
Ready Lo Xl UM

2. You can check the code, error information, and FMI information on the current error.
(See appendix.)

3. Click [View] — [Refresh] menu, or press the [F5] key, or the [Refresh] button on the
“Current Malfunction Information” window to retrieve the most up-to-dated malfunction
information.

B Past Malfunction History

1. Double click [Diagnosis] on the workspace window of the DMS main screen.

2. You can check the code, frequency, occurred time, error information, and FMI
information of the past malfunction. (See appendix.)

3. Click the [Delete Failure] button, such as entering a password will be generated

Enter Password

Enker Password,

Note) Must enter a password to delete failure history as a major factor to check equipment Failure
history

4. Enter the password and then click the OK button will delete the past history of failure

5. Click [View] — [Refresh] menu, or press the [F5] key, or the [Refresh] button on the
“Past Malfunction Information” window to retrieve the most up-to-dated past malfunction
information



9 History Data

9.1 Fuel Consumption

4 Use this function to get various fuel information, such as the fuel use by work
mode, accumulated operation time, filter and oil, and daily operation information.

H Fuel Consumption Info.

» Fuel Consumption information by mode can be found

1. Select [View] — [History] menu on the DMS main screen, or double click [History
Management] — [Fuel Consump